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Section : General English

Ans
B. forgettable
C. disjointed

The public speaker's speech was

A. inspirational

D. monotonous

Q.1 Select the most appropriate adjective to fill in the blank.

, leaving the audience deeply moved.

Question Type :
: 6306801044923
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Question ID

Status

Marks

MCcQ

6306804101835
6306804101832
6306804101834
6306804101833

: Answered
Chosen Option :
:-0.25

D

Ans

B. birds of a feather flock together
C. there's no place like home

D. great minds think alike

Q.2 Select the proverb that can substitute the underlined phrase in the given sentence.

The after-school art club was a magnet for students who loved to draw and paint. As
the saying goes, people with similar interests tend to find each other.

A. opposites attract

Question Type :

Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :
Status :

Chosen Option :
Marks :

McQ
630680735717
6306802883589
6306802883587
6306802883588
6306802883590
Answered

Cc

-0.25
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Q.3 Select the most appropriate option that can substitute the highlighted word in the
given sentence.

Mr. Trivedi running every morning.

Ans A. run
B. runs
C. runned

D. ran

Question Type : MCQ
Question ID : 6306801051710
Option 11D : 6306804129258
Option 2 ID : 6306804129257
Option 3 ID : 6306804129260
Option 4 ID : 6306804129259
Status : Answered
Chosen Option : B
Marks : 1

Q.4 Select the option that corrects the usage of the homonym in the given
sentence.
The mountain pique was steep and challenging for trekking.
Ans A. The mountain peek was steep and challenging for trekking.
B. The mountain peak was steep and challenging for trekking.
C. The mountain pick was steep and challenging for trekking.

D. The mountain peke was steep and challenging for trekking.

Question Type : MCQ
Question ID : 6306801045398
Option 11D : 6306804103717
Option 2 ID : 6306804103716
Option 3 ID : 6306804103718
Option 4 ID : 6306804103719
Status : Answered
Chosen Option: C
Marks : -0.25
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Q.5 Select the most appropriate option to fill in the blank.

After the roller coaster ride, everyone emerged from the car feeling
laughing about the wild twists and turns.

A. giddy

, while

Ans
B. conscious

C. wholesome
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D. empty
Question Type : MCQ
Question ID : 6306801047082
Option 11D : 6306804110442
Option 2 ID : 6306804110444
Option 3 ID : 6306804110445
Option 4 ID : 6306804110443
Status : Answered
Chosen Option : B
Marks : -0.25
Q.6 Which word is INCORRECTLY spelt in the given sentence?
The orchestra's perfomance of the symphony was met with thunderous applause.
Ans A. perfomance
B. thunderous
C. symphony
D. orchestra's
Question Type : MCQ
Question ID : 630680751835
Option 11D : 6306802946750
Option 2 ID : 6306802946752
Option 3 ID : 6306802946751
Option 4 ID : 6306802946749
Status : Answered
Chosen Option : B
Marks : -0.25
Q.7 Select the most appropriate meaning of the given proverb.
A fool and his money are soon parted.
Ans A. Money owned by a fool stays on with him for a long time as he doesn’t know how to
spend it
B. A person who is not sensible usually loses his money
C. Afool earns a lot of money but cannot save it from thieves
D. Afool spends his money by giving parties
Question Type : MCQ
Question ID : 630680757013
Option 11D : 6306802967011
Option 2 ID : 6306802967008
Option 3 ID : 6306802967010
Option 4 ID : 6306802967009
Status : Answered
Chosen Option : B
Marks : 1
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Q.8 Select the most appropriate pair of homonyms to fill in the blanks.

Samaira was ready to the teachings of yoga for both body and mind,
the strict practices that didn’t resonate with her approach to mindfulness
and balance.
Ans A. except; accept

B. except; except
C. accept; except

D. accept; accept

Question Type : MCQ
Question ID : 6306801058344
Option 11D : 6306804155748
Option 2 ID : 6306804155749
Option 3 ID : 6306804155750
Option 4 ID : 6306804155747
Status : Answered
Chosen Option: C
Marks : 1

Q.9 Select the most appropriate meaning of the given proverb.

An empty vessel makes much noise
Ans A. Not to get involved in an unknown issue
B. Alady quarrels in the kitchen

C. Fools often talk a lot

D. Big utensils create much sound

Question Type : MCQ
Question ID : 630680745557
Option 11D : 6306802922423
Option 2 ID : 6306802922426
Option 3 ID : 6306802922425
Option 4 ID : 6306802922424
Status : Answered
Chosen Option : C
Marks : 1

Q.10 Select the most appropriate option to fill in the blanks.
| completed my work, went to my room and read a book for half an hour. books |
read are full of suspense and thrill. That is most relaxing time of my entire day.

Ans A A a
B. A, the
C. An, the
D. The, the

Question Type : MCQ
Question ID : 63068080482
Option 11D : 630680311956
Option 21D : 630680311953
Option 3 ID : 630680311955
Option 4 ID : 630680311954

Status : Answered

Chosen Option : A

Marks : -0.25
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Q.11 Select the option that expresses the given sentence in indirect speech.

The police said to the man, “Who are you? Where do you come from?”

Ans A. The police asked the man who he was and where he came from.
B. The police ask the man who he was and where he came from.
C. The police ask the man who are you, where did you come from.

D. The police asked the man who are you, where do you come from.
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Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
630680297421
6306801157145
6306801157144
6306801157146
6306801157143
Answered

D

-0.25

Q.12 Select the most appropriate adjective to replace the underlined word in the given
sentence.

The delicious weather made the picnic enjoyable.

Ans A. savoury
B. horrible
C. pleasant

D. dreadful

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

MCQ
6306801045095
6306804102523
6306804102520
6306804102521
6306804102522
Answered

(]

1
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Q.13 Select the most appropriate option to fill in the blank.

Despite his condition, marked by extreme poverty and lack of
resources, he maintained a generous spirit and always found ways to help those in
need.
Ans A. avaricious
B. capricious
C. vicarious

D. penurious

Question Type : MCQ
Question ID : 6306801056014
Option 11D : 6306804146567
Option 2 ID : 6306804146566
Option 3 ID : 6306804146569
Option 4 ID : 6306804146568
Status : Answered
Chosen Option : B
Marks : -0.25

Q.14 Select the most appropriate ANTONYM of the given word.

Indifference
Ans A. Hatred

B. Apathy
C. Enthusiasm

D. Dislike

Question Type : MCQ
Question ID : 630680727287
Option 11D : 6306802849940
Option 2 ID : 6306802849937
Option 3 ID : 6306802849938
Option 4 ID : 6306802849939
Status : Answered
Chosen Option : B
Marks : -0.25

Q.15 Select the most appropriate ANTONYM of the underlined word in the given sentence.

She is very popular as she bears no malice towards anyone.

Ans A. humility
B. spirituality
C. hatred

D. goodwill

Question Type : MCQ
Question ID : 630680685154
Option 11D : 6306802683118
Option 2 1D : 6306802683119
Option 3 ID : 6306802683116
Option 4 ID : 6306802683117
Status : Answered
Chosen Option : C
Marks : -0.25
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Q.16 Select the most appropriate option to fill in the blank.

A sudden downpour the quiet village fair into a chaotic carnival.

Ans A. turning
B. turn
C. be turned

D. turned
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Question Type : MCQ
Question ID : 630680560542
Option 11D : 6306802191146
Option 21D : 6306802191144
Option 3 ID : 6306802191147
Option 4 ID : 6306802191145
Status : Answered
Chosen Option : B
Marks : -0.25
Q.17 Select the most appropriate ANTONYM of the underlined word.
Abhishek evinced great enthusiasm for working on that ambitious project.
Ans A. Examined
B. Concealed
C. Demonstrated
D. Proved
Question Type : MCQ
Question ID : 630680728440
Option 11D : 6306802854520
Option 2 ID : 6306802854517
Option 3 ID : 6306802854518
Option 4 ID : 6306802854519
Status : Answered
Chosen Option : C
Marks : -0.25
Q.18 Select the most appropriate option to fill in the blank.
During a morning walk, early riser enjoyed a fresh breeze and an invigorating
sunrise, making it perfect start to the day.
Ans A. an; an
B. an; a
C.a;an
D.a;a
Question Type : MCQ
Question ID : 6306801047070
Option 11D : 6306804110397
Option 2 ID : 6306804110396
Option 3 ID : 6306804110395
Option 4 ID : 6306804110394
Status : Answered
Chosen Option : B
Marks : 1
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Q.19 Select the most appropriate meaning of the given proverb.
A goose quill is more dangerous than a lion’s claw

Ans A. A goose is more powerful than a lion
B. One should not fight with a goose
C. Inconsiderate words are more painful than physical attacks

D. One should not fight with a powerful person
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Question Type :
Question ID :
Option 11D :

: 6306803096500

Option 31D :

: 6306803096503

Status :

Chosen Option :

Marks :

Option 2 ID

Option 4 ID

McQ
630680790180
6306803096501

6306803096502

Answered

C
1

Q.20 Select the INCORRECTLY spelt word in the given sentence.

Ans A. horrified
B. abandond
C. forensic

D. mutilated

The forensic team was horrified to see the mutilated remains in the abandond house.

Question Type :
Question ID :
Option 11D :
Option 21D :

: 6306803156081

Option 4 ID :
Status :

Chosen Option :
Marks :

Option 3 ID

McQ
630680805606
6306803156082
6306803156084

6306803156083
Answered

B

1

Sharda told me that she was going to her village.
Ans A. Sharda says, "l will go to my village."

B. Sharda said, "I'm going to my village."
C. Sharda said, "l was going to a village."

D. Sharda said, "She is going to her village."

Q.21 Select the option that expresses the given sentence in direct speech.

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 41D :

Status :

Chosen Option :

Marks :

MCQ
630680721873
6306802828784
6306802828782
6306802828785
6306802828783
Answered

D

-0.25
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Q.22 Select the most appropriate meaning of the given proverb.

If it ain’t broke, don’t fix it.

Ans A. Fix things even if they work fine.
B. Breaking things is necessary to fix them.
C. Fixing things is important.

D. Don’t change something that's working well.

GET IT ON
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Question Type : MCQ
Question ID : 6306801046019
Option 11D : 6306804106160
Option 21D : 6306804106162
Option 3 ID : 6306804106163
Option 4 ID : 6306804106161
Status : Answered
Chosen Option : B
Marks : -0.25
Q.23 Identify the INCORRECTLY spelt word in the given sentence.
The weather forecaster predicted rain for tommorow.
Ans A. forecaster
B. tommorow
C. weather
D. predicted
Question Type : MCQ
Question ID : 630680754731
Option 1 ID : 6306802958124
Option 2 ID : 6306802958126
Option 3 ID : 6306802958123
Option 4 ID : 6306802958125
Status : Answered
Chosen Option : B
Marks : 1
Q.24 Select the most appropriate ANTONYM of the word highlighted in bold in the given
sentence.
The new law to impose a ban on tobacco is to curb health hazards associated with
smoking and chewing of tobacco.
Ans A. Increase
B. Limit
C. Control
D. Decrease
Question Type : MCQ
Question ID : 630680805414
Option 11D : 6306803155341
Option 2 1D : 6306803155343
Option 3 ID : 6306803155344
Option 4 ID : 6306803155342
Status : Answered
Chosen Option : B
Marks : -0.25
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Q.25 Select the most appropriate ANTONYM of the highlighted word.

Ans A. Resistless
B. Woozy
C. Strong
D. Kind

This type of organisation is rare at present, and there is a general belief that too high a
proportion of mentally infirm people can undermine the effectiveness of relief care.

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :

Option 4 ID

MCcQ

6306801159907
6306804559107
6306804559110
6306804559109

: 6306804559108
Status :
Chosen Option :
Marks :

Answered
(o
1
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Comprehension:
Read the passage carefully and answer the questions that follow.

One of the hallmarks of Roald Dahl's writing style is its simplicity. His prose is clear, concise
and utterly engaging. Dahl masterfully crafts stories that are accessible to readers of all ages
without sacrificing depth or emotional resonance. His choice of words is precise, making it
easy for young readers to grasp the narrative, while still providing a rich reading experience
for adults.

In ‘Matilda’, Dahl introduces us to a brilliant young girl with telekinetic powers. Through Dahl's
straightforward prose, we enter Matilda's world effortlessly. 'It's a funny thing about mothers
and fathers. Even when their own child is the most disgusting little blister you could ever
imagine, they still think that he or she is wonderful', reads one of the endearing quotes in the
book 'Matilda'. Dahl's ability to address complex themes, such as neglect and injustice,
through simple language is a proof of his storytelling intelligence.

In the iconic ‘Charlie and the Chocolate Factory', Dahl invites us into Willy Wonka's candy-
filled wonderland. His descriptions of the factory are brimming with imagination, 'The walls
and ceiling were covered with large patches of something that looked like thick, brown fur
carpet. In the places where there were no patches of fur, there were large splodges of a
revolting greenish mold'. Dahl's vivid imagery allows readers to visualise Wonka's eccentric
world, making it a memorable reading experience.

While Roald Dahl's tales are filled with whimsy and fantasy, they are embraced with important
life lessons. Dahl uses his simple prose to convey messages of kindness, resilience and the
triumph of good over evil. In ‘The Witches', Dahl addresses themes of courage and
resourcefulness as a young boy battles a coven of witches. Dahl's straightforward language
carries a powerful message, 'You are using the bravery of a small boy and the intelligence of
a mouse to defeat your enemy. And you are doing it brilliantly'. Dahl's ability to blend simplicity
with profound themes makes his stories not only enjoyable but also impactful.

SubQuestion No : 26

Q.26 Based on the passage about Roald Dahl's writing, which of the following options is
correct about the story 'The Witches'?

Ans A. It's a lighthearted tale about the joys of friendship and cooperation.

B. It's a suspenseful adventure where a young boy confronts a dangerous threat.
C. It's a humorous story about a young witch learning her craft.

D. It's a complex story exploring human relationships.

Question Type : MCQ
Question ID : 630680805371
Option 11D : 6306803155177
Option 2 ID : 6306803155179
Option 3 ID : 6306803155180
Option 4 ID : 6306803155178
Status : Answered
Chosen Option : B
Marks : 1
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Comprehension:
Read the passage carefully and answer the questions that follow.

One of the hallmarks of Roald Dahl's writing style is its simplicity. His prose is clear, concise
and utterly engaging. Dahl masterfully crafts stories that are accessible to readers of all ages
without sacrificing depth or emotional resonance. His choice of words is precise, making it
easy for young readers to grasp the narrative, while still providing a rich reading experience
for adults.

In ‘Matilda’, Dahl introduces us to a brilliant young girl with telekinetic powers. Through Dahl's
straightforward prose, we enter Matilda's world effortlessly. 'It's a funny thing about mothers
and fathers. Even when their own child is the most disgusting little blister you could ever
imagine, they still think that he or she is wonderful', reads one of the endearing quotes in the
book 'Matilda'. Dahl's ability to address complex themes, such as neglect and injustice,
through simple language is a proof of his storytelling intelligence.

In the iconic ‘Charlie and the Chocolate Factory', Dahl invites us into Willy Wonka's candy-
filled wonderland. His descriptions of the factory are brimming with imagination, 'The walls
and ceiling were covered with large patches of something that looked like thick, brown fur
carpet. In the places where there were no patches of fur, there were large splodges of a
revolting greenish mold'. Dahl's vivid imagery allows readers to visualise Wonka's eccentric
world, making it a memorable reading experience.

While Roald Dahl's tales are filled with whimsy and fantasy, they are embraced with important
life lessons. Dahl uses his simple prose to convey messages of kindness, resilience and the
triumph of good over evil. In ‘The Witches', Dahl addresses themes of courage and
resourcefulness as a young boy battles a coven of witches. Dahl's straightforward language
carries a powerful message, 'You are using the bravery of a small boy and the intelligence of
a mouse to defeat your enemy. And you are doing it brilliantly'. Dahl's ability to blend simplicity
with profound themes makes his stories not only enjoyable but also impactful.
SubQuestion No : 27

Q.27 Select the most appropriate meaning of the word ‘endearing’ as given in the passage.

Ans A. Inspiring love or affection

B. Creating a sense of insecurity

C. Causing harm or injury

D. Provoking anger or irritation

Question Type : MCQ
Question ID : 630680805372
Option 11D : 6306803155182
Option 2 ID : 6306803155183
Option 3 ID : 6306803155181
Option 4 ID : 6306803155184
Status : Answered
Chosen Option: C
Marks : -0.25

htt s://cdn.di ialm.com// er/ 01/ ub/852/touchstone/AssessmentQPHTMLMode1//OSSC241/0SSC241S9D1351/17297514871767219/230738904... 12/75


https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap

Addai2y47 Eooale Play

10/28/24, 7:03 PM cdn.di ialm.com// er/ 01/ ub/852/touchstone/AssessmentQPHTMLMode1/0SSC241/0SSC241S9D1351/17297514871767219/...

Comprehension:
Read the passage carefully and answer the questions that follow.

One of the hallmarks of Roald Dahl's writing style is its simplicity. His prose is clear, concise
and utterly engaging. Dahl masterfully crafts stories that are accessible to readers of all ages
without sacrificing depth or emotional resonance. His choice of words is precise, making it
easy for young readers to grasp the narrative, while still providing a rich reading experience
for adults.

In ‘Matilda’, Dahl introduces us to a brilliant young girl with telekinetic powers. Through Dahl's
straightforward prose, we enter Matilda's world effortlessly. 'It's a funny thing about mothers
and fathers. Even when their own child is the most disgusting little blister you could ever
imagine, they still think that he or she is wonderful', reads one of the endearing quotes in the
book 'Matilda'. Dahl's ability to address complex themes, such as neglect and injustice,
through simple language is a proof of his storytelling intelligence.

In the iconic ‘Charlie and the Chocolate Factory', Dahl invites us into Willy Wonka's candy-
filled wonderland. His descriptions of the factory are brimming with imagination, 'The walls
and ceiling were covered with large patches of something that looked like thick, brown fur
carpet. In the places where there were no patches of fur, there were large splodges of a
revolting greenish mold'. Dahl's vivid imagery allows readers to visualise Wonka's eccentric
world, making it a memorable reading experience.

While Roald Dahl's tales are filled with whimsy and fantasy, they are embraced with important
life lessons. Dahl uses his simple prose to convey messages of kindness, resilience and the
triumph of good over evil. In ‘The Witches', Dahl addresses themes of courage and
resourcefulness as a young boy battles a coven of witches. Dahl's straightforward language
carries a powerful message, 'You are using the bravery of a small boy and the intelligence of
a mouse to defeat your enemy. And you are doing it brilliantly'. Dahl's ability to blend simplicity
with profound themes makes his stories not only enjoyable but also impactful.

SubQuestion No : 28

Q.28 Which of the following options best summarises the passage about Roald Dahl's
writing style?

Ans A. Dahl's books are complex and challenging, meant only for adults.

B. Through fantastical settings, Dahl's stories convey complex messages using
advanced vocabulary.

C. Roald Dahl's writing is too childish and lacks depth.

D. Roald Dahl's engaging writing style combines clear and simple language with rich
themes, making his stories enjoyable for all ages.

Question Type : MCQ
Question ID : 630680805370
Option 11D : 6306803155173
Option 2 1D : 6306803155175
Option 3 ID : 6306803155176
Option 4 ID : 6306803155174
Status : Answered
Chosen Option: C
Marks : -0.25
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Comprehension:
Read the passage carefully and answer the questions that follow.

One of the hallmarks of Roald Dahl's writing style is its simplicity. His prose is clear, concise
and utterly engaging. Dahl masterfully crafts stories that are accessible to readers of all ages
without sacrificing depth or emotional resonance. His choice of words is precise, making it
easy for young readers to grasp the narrative, while still providing a rich reading experience
for adults.

In ‘Matilda’, Dahl introduces us to a brilliant young girl with telekinetic powers. Through Dahl's
straightforward prose, we enter Matilda's world effortlessly. 'It's a funny thing about mothers
and fathers. Even when their own child is the most disgusting little blister you could ever
imagine, they still think that he or she is wonderful', reads one of the endearing quotes in the
book 'Matilda'. Dahl's ability to address complex themes, such as neglect and injustice,
through simple language is a proof of his storytelling intelligence.

In the iconic ‘Charlie and the Chocolate Factory', Dahl invites us into Willy Wonka's candy-
filled wonderland. His descriptions of the factory are brimming with imagination, 'The walls
and ceiling were covered with large patches of something that looked like thick, brown fur
carpet. In the places where there were no patches of fur, there were large splodges of a
revolting greenish mold'. Dahl's vivid imagery allows readers to visualise Wonka's eccentric
world, making it a memorable reading experience.

While Roald Dahl's tales are filled with whimsy and fantasy, they are embraced with important
life lessons. Dahl uses his simple prose to convey messages of kindness, resilience and the
triumph of good over evil. In ‘The Witches', Dahl addresses themes of courage and
resourcefulness as a young boy battles a coven of witches. Dahl's straightforward language
carries a powerful message, 'You are using the bravery of a small boy and the intelligence of
a mouse to defeat your enemy. And you are doing it brilliantly'. Dahl's ability to blend simplicity
with profound themes makes his stories not only enjoyable but also impactful.
SubQuestion No : 29

Q.29 Select the most appropriate title for the passage.

Ans A. Understanding Complex Themes Through Children's Literature

B. The Importance of Simple Language in Writing

C. The Magic of Roald Dahl's Stories

D. A Look at 'Matilda' and 'Charlie and the Chocolate Factory'

Question Type : MCQ
Question ID : 630680805369
Option 11D : 6306803155172
Option 2 ID : 6306803155170
Option 31D : 6306803155169
Option 4 ID : 6306803155171
Status : Answered
Chosen Option : D
Marks : -0.25
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Comprehension:
Read the passage carefully and answer the questions that follow.

One of the hallmarks of Roald Dahl's writing style is its simplicity. His prose is clear, concise
and utterly engaging. Dahl masterfully crafts stories that are accessible to readers of all ages
without sacrificing depth or emotional resonance. His choice of words is precise, making it
easy for young readers to grasp the narrative, while still providing a rich reading experience
for adults.

In ‘Matilda’, Dahl introduces us to a brilliant young girl with telekinetic powers. Through Dahl's
straightforward prose, we enter Matilda's world effortlessly. 'It's a funny thing about mothers
and fathers. Even when their own child is the most disgusting little blister you could ever
imagine, they still think that he or she is wonderful', reads one of the endearing quotes in the
book 'Matilda'. Dahl's ability to address complex themes, such as neglect and injustice,
through simple language is a proof of his storytelling intelligence.

In the iconic ‘Charlie and the Chocolate Factory', Dahl invites us into Willy Wonka's candy-
filled wonderland. His descriptions of the factory are brimming with imagination, 'The walls
and ceiling were covered with large patches of something that looked like thick, brown fur
carpet. In the places where there were no patches of fur, there were large splodges of a
revolting greenish mold'. Dahl's vivid imagery allows readers to visualise Wonka's eccentric
world, making it a memorable reading experience.

While Roald Dahl's tales are filled with whimsy and fantasy, they are embraced with important
life lessons. Dahl uses his simple prose to convey messages of kindness, resilience and the
triumph of good over evil. In ‘The Witches', Dahl addresses themes of courage and
resourcefulness as a young boy battles a coven of witches. Dahl's straightforward language
carries a powerful message, 'You are using the bravery of a small boy and the intelligence of
a mouse to defeat your enemy. And you are doing it brilliantly'. Dahl's ability to blend simplicity
with profound themes makes his stories not only enjoyable but also impactful.

SubQuestion No : 30

Q.30 Select the most appropriate synonym of the word ‘eccentric’ as given in the following
sentence from the given passage.

'Dahl's vivid imagery allows readers to visualise Wonka's eccentric world, making it a
memorable reading experience’'.

Ans A. Ordinary
B. Conventional
C. Strange

D. Familiar

Question Type : MCQ
Question ID : 630680805373
Option 11D : 6306803155185
Option 2 ID : 6306803155186
Option 3 ID : 6306803155187
Option 4 ID : 6306803155188
Status : Answered
Chosen Option : A
Marks : -0.25
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Q.31

Ans

Comprehension:

Read the given passage and answer the questions that follow.

Grapes are one of the most commonly consumed fruits in any Indian household. However, it
is not hidden that grapes are heavily contaminated with pesticides, and consuming such fruits

can lead to various health issues — including potential harm to the nervous system,
disruption of hormone function and an increased risk of cancer.

But what if you can grow these juicy delights easily at home in containers?

Delhi-based urban gardener Rashmi Shukla has been growing grapes on the rooftop of her
house for the last seven years. She says growing grapevines in a grow bag and container is
not very cumbersome and can be done with little care. And as a bonus, your garden will be

frequented by a lot of birds!

According to Rashmi, grapes can be grown through seeds as well as cuttings but gardeners
should opt for a sapling. “It will substantially reduce the time taken for the plant to bear fruits.
If you use seeds, it may take many years before fruiting, while a sapling can fruit in three
years if properly nurtured,” she adds.

SubQuestion No : 31
What potential health issues are associated with consuming pesticide-contaminated

grapes?
A. Allergic reactions and low-grade fever
B. Nervous system harm, hormone disruption and increased cancer risk
C. Cardiovascular diseases and pulmonary disorders

D. Respiratory problems and indigestion
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Option 11D :
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Status :

Chosen Option :

Marks :

MCcQ
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Comprehension:
Read the given passage and answer the questions that follow.

can lead to various health issues — including potential harm to the nervous system,
disruption of hormone function and an increased risk of cancer.

But what if you can grow these juicy delights easily at home in containers?

frequented by a lot of birds!

years if properly nurtured,” she adds.

SubQuestion No : 32
Q.32 Which of the following is the most appropriate title for the passage?

Ans A. The Popularity of Grapes in Indian Households
B. The Health Risks of Consuming Grapes
C. The Nutritional Benefits of Grapes

D. Growing Grapes at Home: A Guide by an Urban Gardener

Grapes are one of the most commonly consumed fruits in any Indian household. However, it
is not hidden that grapes are heavily contaminated with pesticides, and consuming such fruits

Delhi-based urban gardener Rashmi Shukla has been growing grapes on the rooftop of her
house for the last seven years. She says growing grapevines in a grow bag and container is
not very cumbersome and can be done with little care. And as a bonus, your garden will be

According to Rashmi, grapes can be grown through seeds as well as cuttings but gardeners
should opt for a sapling. “It will substantially reduce the time taken for the plant to bear fruits.
If you use seeds, it may take many years before fruiting, while a sapling can fruit in three

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
630680796694
6306803121753
6306803121752
6306803121755
6306803121754
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Comprehension:
Read the given passage and answer the questions that follow.

can lead to various health issues — including potential harm to the nervous system,
disruption of hormone function and an increased risk of cancer.

But what if you can grow these juicy delights easily at home in containers?

frequented by a lot of birds!

years if properly nurtured,” she adds.

SubQuestion No : 33
Q.33 What does the word ‘cumbersome’ mean in the passage?

Ans A. Quick
B. Fun
C. Easy
D. Difficult

Grapes are one of the most commonly consumed fruits in any Indian household. However, it
is not hidden that grapes are heavily contaminated with pesticides, and consuming such fruits

Delhi-based urban gardener Rashmi Shukla has been growing grapes on the rooftop of her
house for the last seven years. She says growing grapevines in a grow bag and container is
not very cumbersome and can be done with little care. And as a bonus, your garden will be

According to Rashmi, grapes can be grown through seeds as well as cuttings but gardeners
should opt for a sapling. “It will substantially reduce the time taken for the plant to bear fruits.
If you use seeds, it may take many years before fruiting, while a sapling can fruit in three

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
630680796698
6306803121771
6306803121770
6306803121768
6306803121769
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Comprehension:
Read the given passage and answer the questions that follow.

can lead to various health issues — including potential harm to the nervous system,
disruption of hormone function and an increased risk of cancer.

But what if you can grow these juicy delights easily at home in containers?

frequented by a lot of birds!

years if properly nurtured,” she adds.

SubQuestion No : 34
Q.34 What can be inferred about growing grapes at home?

Ans A. It requires a significant amount of effort and expertise.
B. It is impossible to grow grapes in urban areas.
C. It can attract birds to your garden.

D. It is more expensive than buying grapes from the market.

Grapes are one of the most commonly consumed fruits in any Indian household. However, it
is not hidden that grapes are heavily contaminated with pesticides, and consuming such fruits

Delhi-based urban gardener Rashmi Shukla has been growing grapes on the rooftop of her
house for the last seven years. She says growing grapevines in a grow bag and container is
not very cumbersome and can be done with little care. And as a bonus, your garden will be

According to Rashmi, grapes can be grown through seeds as well as cuttings but gardeners
should opt for a sapling. “It will substantially reduce the time taken for the plant to bear fruits.
If you use seeds, it may take many years before fruiting, while a sapling can fruit in three

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
630680796697
6306803121764
6306803121767
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Q.35

Ans

Comprehension:

Read the given passage and answer the questions that follow.

Grapes are one of the most commonly consumed fruits in any Indian household. However, it
is not hidden that grapes are heavily contaminated with pesticides, and consuming such fruits

can lead to various health issues — including potential harm to the nervous system,
disruption of hormone function and an increased risk of cancer.

But what if you can grow these juicy delights easily at home in containers?

Delhi-based urban gardener Rashmi Shukla has been growing grapes on the rooftop of her
house for the last seven years. She says growing grapevines in a grow bag and container is
not very cumbersome and can be done with little care. And as a bonus, your garden will be

frequented by a lot of birds!

According to Rashmi, grapes can be grown through seeds as well as cuttings but gardeners
should opt for a sapling. “It will substantially reduce the time taken for the plant to bear fruits.
If you use seeds, it may take many years before fruiting, while a sapling can fruit in three
years if properly nurtured,” she adds.

SubQuestion No : 35

According to Rashmi Shukla, how long does it take for a grapevine sapling to bear
fruit if properly nurtured?

A. One year
B. Seven years
C. Three years

D. Five years
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Question ID :
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Option 41D :

Status :

Chosen Option :
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Question Type :
Question ID :
Option 11D :
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Option 4 ID :

Status :

Chosen Option :
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Status :

Chosen Option :
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Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 41D :

Status :

Chosen Option :

Marks :

MCQ
6306801104891
6306804340093
6306804340095
6306804340094
6306804340096
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C

-0.25
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Ans A.

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 41D :

Status :

Chosen Option :

Marks :

McQ
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Question Type :
Question ID :
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Status :

Chosen Option :

Marks :

MCcQ
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Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

MCQ
6306801104943
6306804340302
6306804340304
6306804340301
6306804340303
Answered
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Status :

Chosen Option :

Marks :

McQ
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Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

MCQ
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6306804409435
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Question Type :
Question ID :
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Status :
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McQ
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SubQuestion No : 21

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
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SubQuestion No : 22

Option 1 ID

Question Type :
Question ID :

: 6306804542557
Option 21D :
Option 31D :
Option 4 1D :
Status :

Chosen Option :
Marks :

MCcQ
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6306804542556
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SubQuestion No : 23

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
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6306804542541
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SubQuestion No : 24

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

MCcQ
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Answered

A

1

htt s://cdn.di ialm.com// er/ 01/ ub/852/touchstone/AssessmentQPHTMLMode1//OSSC241/0SSC241S9D1351/17297514871767219/230738904... 34/75


https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap

Adda247

10/28/24, 7:03 PM

GET IT ON

Google Play

cdn.di ialm.com// er/ 01/ ub/852/touchstone/AssessmentQPHTMLMode1//0SSC241/0SSC241S9D1351/17297514871767219/...

Q.25

Ans

Comprehension:

A @E2ER |
ZeRa 2910 @Y T6Q 26l 2IF 2659s APERIdIR FIIRR 699 69IR @gg |

SubQuestion No : 25

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 41D :

Status :

Chosen Option :

Marks :

McQ
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SubQuestion No : 26

Question Type :
Question ID :

Option 11D

McQ
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Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :
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6306804507676
6306804507679
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SubQuestion No : 27

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
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Chosen Option :

Marks :

McQ
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SubQuestion No : 28

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :

Option 4 ID
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6306804507683
6306804507681
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Status :
Chosen Option :
Marks :
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Question ID
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :
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Comprehension:

SubQuestion No : 30

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 41D :

Status :

Chosen Option :

Marks :

MCQ
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Question Type :
Question ID :
Option 11D :
Option 21D :
Option 3 ID :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
6306801158075
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Question ID :
Option 11D :
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Marks :
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Question ID :

Option 1 ID

Option 3 ID
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Option 21D :
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Option 4 ID :
Status :

Chosen Option :
Marks :
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Comprehension:

SubQuestion No : 34
Q.34

Ans

C. A

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

MCcQ
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Comprehension:

SubQuestion No : 35
Q.35

Ans A.

Question Type :
Question ID :
Option 11D :
Option 21D :

Option 3 ID

Status

McQ

6306801158072
6306804551415
6306804551417

: 6306804551416
Option 4 ID :

6306804551414

. Answered
Chosen Option :
Marks :

D
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ampere in one hour?

Q.1 How much of charge will flow through a circuit carrying direct current of one milli-

GET IT ON
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Ans A. 0.36 coulomb
B. 360 coulomb
C. 3.6 coulomb
D. 3600 coulomb
Question Type : MCQ
Question ID : 630680517122
Option 11D : 6306802020887
Option 21D : 6306802020885
Option 3 ID : 6306802020886
Option 4 ID : 6306802020884
Status : Answered
Chosen Option : B
Marks : -0.25
Q.2 Innovations for Defence Excellence (iDEX), a flagship initiative of the Ministry of
Defence, signed its 250" contract under which of the following?
Ans A. Mission DefSpace
B. Mission Khanja
C. Mission Tapas
D. Mission MetaMorph
Question Type : MCQ
Question ID : 630680629933
Option 11D : 6306802465647
Option 2 ID : 6306802465650
Option 3 ID : 6306802465649
Option 4 ID : 6306802465648
Status : Answered
Chosen Option : C
Marks : -0.25
Q.3 Which of the following proteins acts as a glue that holds sister chromatids together
until they separate at anaphase?
Ans A. Cyclin-E1
B. Cohesin
C. Geminin
D. Securin
Question Type : MCQ
Question ID : 630680711286
Option 11D : 6306802786804
Option 2 ID : 6306802786802
Option 3 ID : 6306802786803
Option 4 ID : 6306802786801
Status : Answered
Chosen Option : B
Marks : 1

htt s://cdn.di ialm.com// er/ 01/ ub/852/touchstone/AssessmentQPHTMLMode1//OSSC241/0SSC241S9D1351/17297514871767219/230738904...

46/75


https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap

Adda

10/28/24, 7:03 PM

e

Q.4 Which physicist is credited with proposing the wave nature of matter?
Ans A. Niels Bohr

B. Max Planck

C. Werner Heisenberg

D. Louis de Broglie
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Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

MCcQ
630680774549
6306803036075
6306803036078
6306803036076
6306803036077
Answered

Cc

-0.25

Q.5 Who among the following people is the first Indian to embark on a journey into the
space as a tourist?

Ans A. Narendra Sharma
B. Aarohi Pandit
C. Gopichand Thotakura

D. Ayesha Aziz

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

MCcQ
630680750549
6306802941635
6306802941636
6306802941634
6306802941637
Answered

B

-0.25

Q.6 Which of these are tiny pores in plants that regulate the passage of oxygen, carbon
dioxide and water vapour into and out of cells?

Ans A. Stomata
B. Pith
C. Vacuole

D. Sieve tube

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

MCQ
630680750800
6306802942626
6306802942629
6306802942627
6306802942628
Answered
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Q.7 India's first 5.5-generation stealth fighter, the AMCA, is being developed by which
organisation, and what are they currently seeking?
Ans A. BEL; suppliers of advanced materials
B. ISRO; international buyers
C. DRDO; development and production partners
D. HAL; foreign technical assistance
Question Type : MCQ
Question ID : 6306801065029
Option 11D : 6306804182398
Option 2 ID : 6306804182397
Option 3 ID : 6306804182400
Option 4 ID : 6306804182399
Status : Answered
Chosen Option: C
Marks : 1
Q.8 The Brewster’s law formula is defined as (ig : Brewster’s angle of incidence):
Ans A. Tan™ (ig)
B. Tanig = cos ig /sin ig
C.Tanig =sinig/ cosig
D. Tan™ (ig) = sinig / cos ig
Question Type : MCQ
Question ID : 630680303270
Option 11D : 6306801179737
Option 21D : 6306801179734
Option 3 ID : 6306801179735
Option 4 ID : 6306801179736
Status : Answered
Chosen Option : B
Marks : -0.25
Q.9 Rhizome and stolon are examples of modified stem, both of which are used by plants
for:
Ans A. asexual reproduction
B. photo respiration
C. sexual reproduction
D. photosynthesis
Question Type : MCQ
Question ID : 630680668952
Option 11D : 6306802619313
Option 2 ID : 6306802619315
Option 3 ID : 6306802619316
Option 4 ID : 6306802619314
Status : Answered
Chosen Option : B
Marks : -0.25
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kilometres away. The test, conducted from a Su-30 MKI fighter jet in

capabilities.
Ans A. 200; Rajasthan
B. 300; the Kadmat Island
C. 250; the Andaman and Nicobar Islands

D. 150; the Lakshadweep Island

Q.10 The Indian Air Force achieved a milestone by successfully test-firing an air-launched
ballistic missile, ROCKS or Crystal Maze 2, capable of hitting targets over

demonstrates India's commitment to enhancing defense

GET IT ON

Google Play
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Question Type :
Question ID :

Option 1 ID

Chosen Option

McQ
6306801047636

1 6306804112609
Option 21D :
Option 31D :
Option 41D :

Status :
:C
Marks :

6306804112612
6306804112611
6306804112610
Answered

1

in Kerala, for the first time in the General Elections 20247

Ans A. MV Jayakaran
B. Suresh Gopi
C. V Vaseef

D. MK Raghvan

Q.11 What is the name of the candidate who has won a seat for Bharatiya Janta Party (BJP),

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
6306801050031
6306804122474
6306804122473
6306804122475
6306804122476
Answered

B

1
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Q.12 In which city of India and on which date will 'The Venture Capital World Summit' be
held?

Ans A. Mumbai, 215t October 2024
B. Hyderabad, 10" December 2024
C. Delhi, 251" November 2024

D. Bengaluru, 15t September 2024

GET IT ON
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Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
6306801057049
6306804150630
6306804150632
6306804150631
6306804150629
Answered

B

-0.25

Q.13 Which nation introduced the first-ever 100% biodegradable pen to the world in 2024?

Ans A. Germany
B. Japan
C. China

D. India

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 1D :

Status :

Chosen Option :

Marks :

McQ
6306801062078
6306804170696
6306804170695
6306804170694
6306804170693
Answered

D

1

Q.14 Who made history as the first Indian gymnast to claim a gold medal at the 2024 Asian
Gymnastics Championships?

Ans A. Ashish Kumar
B. Dipa Karmakar
C. Sham Lal

D. Pranati Nayak

Question Type :
Question ID :
Option 11D :
Option 211D :
Option 31D :
Option 41D :

Status :

Chosen Option :

Marks :

MCcQ
6306801062341
6306804171751
6306804171749
6306804171752
6306804171750
Answered

B

1
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Q.15 Germany became the member of the United Nations Command (UNC) in 2024.
Ans A. 18t
B. 17t
c. 15
D. 16t
Question Type : MCQ
Question ID : 6306801057003
Option 11D : 6306804150440
Option 2 1D : 6306804150439
Option 3 ID : 6306804150437
Option 4 ID : 6306804150438
Status : Answered
Chosen Option : B
Marks : -0.25
Q.16 According to Budget 2024-25, what is the new corporate tax rate for foreign companies
which was 40% earlier?
Ans A. 35%
B. 33.55%
C.31%
D. 32%
Question Type : MCQ
Question ID : 6306801050109
Option 11D : 6306804122781
Option 2 ID : 6306804122783
Option 3 ID : 6306804122784
Option 4 ID : 6306804122782
Status : Answered
Chosen Option : B
Marks : -0.25
Q.17 HS Prannoy won which of the following medals at BWF World Badminton
Championships 20237
Ans A. No Medals
B. Gold
C. Bronze
D. Silver
Question Type : MCQ
Question ID : 630680840792
Option 11D : 6306803293817
Option 2 1D : 6306803293814
Option 3 ID : 6306803293816
Option 4 ID : 6306803293815
Status : Answered
Chosen Option : C
Marks : 1
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Q.18 Which nation introduced the '"Minuteman III', an intercontinental ballistic missile, in
20247

Ans A. France
B. Japan
C. The US

D. Russia

Question Type : MCQ
Question ID : 6306801062199
Option 11D : 6306804171186
Option 21D : 6306804171187
Option 3 ID : 6306804171185
Option 4 ID : 6306804171188
Status : Answered
Chosen Option: C
Marks : 1

Q.19 Who was awarded Dhyan Chand Award for Lifetime Achievement in Sports and Games
2023 for the sport of badminton?

Ans A. Kavitha Selvaraj
B. Manjusha Kanwar
C. Sunil Kumar

D. Bhaskaran E

Question Type : MCQ
Question ID : 6306801050015
Option 11D : 6306804122409
Option 2 ID : 6306804122411
Option 3 ID : 6306804122412
Option 4 ID : 6306804122410
Status : Answered
Chosen Option : B
Marks : 1

Q.20 Which international organisation collaborated with the Ministry of Ayush, Government
of India, in the signing of the Donor Agreement in 2024?

Ans A. World Trade Organization (WTO)
B. United Nations International Children's Emergency Fund (UNICEF)
C. World Health Organization (WHO)

D. United Nations Educational, Scientific and Cultural Organization (UNESCO)

Question Type : MCQ
Question ID : 6306801057012
Option 11D : 6306804150476
Option 2 ID : 6306804150475
Option 3 ID : 6306804150474
Option 4 ID : 6306804150473
Status : Answered
Chosen Option: C
Marks : 1

Section : History of India
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Q.21 Who among the following Mughal emperors died while climbing down the stairs of his

GET IT ON

Google Play

cdn.di ialm.com// er/ 01/ ub/852/touchstone/AssessmentQPHTMLMode1//0SSC241/0SSC241S9D1351/17297514871767219/...

library?
Ans A. Humayun
B. Sher Shah
C. Akbar
D. Babar
Question Type : MCQ
Question ID : 630680766058
Option 11D : 6306803002671
Option 2 ID : 6306803002668
Option 3 ID : 6306803002670
Option 4 ID : 6306803002669
Status : Answered
Chosen Option : B
Marks : -0.25
Q.22 Who among the following Governor-Generals followed the policy of non-interference
into the affairs of Indian states?
Ans A. Lord Dufferin
B. Lord Dalhousie
C. Lord Lytton
D. Lord William Bentinck
Question Type : MCQ
Question ID : 630680595490
Option 11D : 6306802330148
Option 2 ID : 6306802330149
Option 3 1D : 6306802330151
Option 4 ID : 6306802330150
Status : Answered
Chosen Option : B
Marks : -0.25
Q.23 The Moplah uprising took place in which of the States of India?
Ans A. Gujarat
B. Orissa
C. Kerala
D. Tamil Nadu
Question Type : MCQ
Question ID : 630680577963
Option 11D : 6306802260710
Option 21D : 6306802260713
Option 3 ID : 6306802260712
Option 4 ID : 6306802260711
Status : Answered
Chosen Option : A
Marks : -0.25
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Q.24 Where did the Greeks set up their kingdom during the Maurya dynasty, subsequently
invading India?

Ans A. Transoxiana
B. Bactria
C. Babylonia
D. Sogdiana

Question Type : MCQ
Question ID : 630680571249
Option 11D : 6306802234034
Option 2 1D : 6306802234035
Option 3 ID : 6306802234033
Option 4 ID : 6306802234036
Status : Answered
Chosen Option: C
Marks : -0.25

Q.25 The Zend-Avesta is the main book of the followers of which religion?
Ans A. Jainism

B. Judaism
C. Parsi religion

D. Christianity

Question Type : MCQ
Question ID : 630680650160
Option 11D : 6306802545644
Option 2 ID : 6306802545646
Option 3 ID : 6306802545645
Option 4 ID : 6306802545647
Status : Answered
Chosen Option : B
Marks : -0.25

Q.26 Who among the following was deputed to attend the First Round Table Conference in
November 1930 in London by the Government of Bihar and Orissa?

Ans A. Hariharrao Raghunathrao
B. Bhalchandrarao Chintamanrao
C. Krushna Chandra Gajapati
D. Dayanidhi Dharua

Question Type : MCQ
Question ID : 6306801135821
Option 11D : 6306804463414
Option 2 ID : 6306804463415
Option 3 ID : 6306804463416
Option 4 ID : 6306804463417
Status : Answered
Chosen Option : B
Marks : -0.25
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Q.27 Who among the following was the first Indian member of the Viceroy's Executive
Council?

Ans A. RC Dutt
B. SP Sinha
C. Dadabhai Naoroji

D. GK Gokhale

GET IT ON
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Question Type :
Question ID :
Option 11D :
: 6306801890103
Option 31D :
Option 4 ID :
Status :

Chosen Option :

Marks :

Option 2 ID

McQ
630680483935
6306801890105

6306801890102
6306801890104
Answered

(o]

-0.25

Q.28 Whom had Gandhi named as Mira Behn?
Ans A. Madeleine Slade

B. Annie Besant
C. Kamla Devi

D. Indira Gandhi

Question Type

:McQ
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

630680607676
6306802377812
6306802377809
6306802377810
6306802377811
Answered

B

-0.25

Q.29 Which of the following cities served as the capital of the Pandya kingdom?

Ans A. Cholaipattinam
B. Thanjavur
C. Kanchipuram

D. Madurai

Question Type :
: 630680766048
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :
Status :

Chosen Option :
Marks :

Question ID

McQ

6306803002627
6306803002625
6306803002626
6306803002624
Answered

Cc

-0.25
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Q.30 The Paramhans Mandali was founded in

to work for the abolition of caste.

GET IT ON
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Ans A. Nagpur
B. Nanded
C. Nasik
D. Bombay
Question Type : MCQ
Question ID : 630680595732
Option 11D : 6306802331116
Option 2 ID : 6306802331119
Option 3 ID : 6306802331117
Option 4 ID : 6306802331118
Status : Answered
Chosen Option: C
Marks : -0.25
Section : Geography
Q.31 Which two states in the North-Western Region have rich sources of salt?
Ans A. Rajasthan and Haryana
B. Rajasthan and Gujarat
C. Gujarat and Madhya Pradesh
D. Punjab and Gujarat
Question Type : MCQ
Question ID : 630680662896
Option 11D : 6306802595250
Option 2 ID : 6306802595248
Option 3 ID : 6306802595249
Option 4 ID : 6306802595251
Status : Answered
Chosen Option: C
Marks : -0.25
Q.32 Which of the following river islands, formed as a cluster of many small islands, claims
the title of being the largest river island in India?
Ans A. Majuli Island
B. Andaman lIsland
C. Shivaji Island
D. Sunderbans Island
Question Type : MCQ
Question ID : 630680662869
Option 11D : 6306802595138
Option 2 ID : 6306802595139
Option 3 ID : 6306802595136
Option 4 ID : 6306802595137
Status : Answered
Chosen Option : B
Marks : -0.25
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Q.33 Which of the following regions is one of Earth’s last refuges for jaguars, harpy eagles,
and pink river dolphins, and is home to sloths, black spider monkeys, and poison dart
frogs?

Ans A. South African Safari
B. Arctic
C. Nile river

D. Amazon

Question Type : MCQ
Question ID : 6306801064196
Option 11D : 6306804179123
Option 2 ID : 6306804179125
Option 3 ID : 6306804179126
Option 4 ID : 6306804179124
Status : Answered
Chosen Option: C
Marks : -0.25

Q.34 Which of the following river valleys is NOT known for coal reserves in India?
Ans A. Damodar

B. Mahanadi
C. Yamuna

D. Godavari

Question Type : MCQ
Question ID : 630680652001
Option 11D : 6306802552530
Option 2 1D : 6306802552532
Option 3 ID : 6306802552533
Option 4 ID : 6306802552531
Status : Answered
Chosen Option: C
Marks : 1

Q.35 Through which of the following states does the Shetruniji (Shetrunji) river flow?
Ans A. Jharkhand

B. Tamil Nadu
C. Rajasthan

D. Gujarat

Question Type : MCQ
Question ID : 63068087508
Option 11D : 630680339420
Option 21D : 630680339419
Option 3 ID : 630680339417
Option 4 ID : 630680339418
Status : Answered
Chosen Option: C
Marks : -0.25
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A. Petroleum
B. Coal
C. Solar

D. Natural gas

Q.36 If the government wants to improve the access to electricity in rural areas of India,
which of the following energy sources should they prioritise for the decentralised
power generation?
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Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

MCcQ
630680874776
6306803426012
6306803426009
6306803426011
6306803426010
Answered

Cc

1

Ans

Q.37 The desert present between the western central Andes and the Pacific Coast is

A. Gobi Desert
B. Atacama Desert
C. Thar Desert

D. Sahara Desert

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 3 ID :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
6306801077553
6306804232213
6306804232210
6306804232212
6306804232211
Answered

D

-0.25

Ans

Q.38 'Dun’is a typical feature of:

A. Assam Himalaya

B. Arunachal Himalaya

C. Uttaranchal Himalaya

D. Sikkim Himalaya

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
630680655654
6306802566589
6306802566588
6306802566586
6306802566587
Answered

B

-0.25
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Q.39 The Sardar Sarovar Dam is constructed on which river?
Ans A. Satluj

B. Kaveri

C. Periyar

D. Narmada
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Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 1D :

Status

Chosen Option :
Marks :

McQ
630680652056
6306802552747
6306802552748
6306802552749
6306802552746

. Answered

D
1

Q.40 What is the texture of the alluvial soils found in the piedmont plains of Terai?

Ans A. Loamy
B. Clayey
C. Fine to medium

D. Coarse

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :

Option 4 ID

McQ
63068087945
630680341167
630680341168
630680341166

: 630680341165
Status :
Chosen Option :
Marks :

Answered
C
-0.25

Section : Indian polity and Economy

Q.41 Despite the Supreme Court's ruling on Part IX-B, which provisions related to
cooperative societies remain valid?

Ans A. Provisions related to single-state cooperative societies
B. Provisions related to private cooperative societies
C. Provisions related to multi-state cooperative societies

D. Provisions related to foreign cooperative societies

Question Type :
Question ID :
Option 11D :
Option 21D :

Option 3 ID

McQ

6306801044828
6306804101464
6306804101465

: 6306804101466
Option 4 ID :
Status :

Chosen Option :
Marks :

6306804101467
Answered

B

-0.25
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Q.42 How many commercial courts are functioning in Odisha as of September 2024?
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Ans A.6
B.4
C.5
D.3
Question Type : MCQ
Question ID : 6306801126268
Option 11D : 6306804425289
Option 2 ID : 6306804425287
Option 3 ID : 6306804425288
Option 4 ID : 6306804425286
Status : Answered
Chosen Option : D
Marks : 1
Q.43 In which part of the Constitution of India are the Fundamental Rights included?
Ans A. Part lll
B. Part IV
C. Part IX
D. PartV
Question Type : MCQ
Question ID : 630680733130
Option 11D : 6306802873313
Option 2 1D : 6306802873314
Option 3 ID : 6306802873316
Option 4 ID : 6306802873315
Status : Answered
Chosen Option : A
Marks : 1
Q.44 The first unit of the NTPC Talcher Kaniha plant, located in the Angul district of Odisha,
was commissioned in which year with a capacity of 500 MW?
Ans A. 2005
B. 1990
C. 2000
D. 1995
Question Type : MCQ
Question ID : 6306801146926
Option 11D : 6306804507831
Option 2 1D : 6306804507828
Option 3 ID : 6306804507330
Option 4 ID : 6306804507829
Status : Answered
Chosen Option : B
Marks : -0.25
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Q.45 Under which of the following conditions can Indian citizenship NOT be acquired by
registration?

Ans A. The person is of Indian origin living in any country.
B. They are minor children of persons who are Indian citizens.
C. The person is a foreign diplomat stationed in India.

D. The person is married to an Indian citizen and resides in India.

Question Type : MCQ
Question ID : 630680783857
Option 11D : 6306803071795
Option 2 ID : 6306803071797
Option 3 ID : 6306803071798
Option 4 ID : 6306803071796
Status : Answered
Chosen Option : B
Marks : -0.25

Q.46 In air pollution, the concepts of PM 2.5 and PM 10 are often used. What does PM stand
for?

Ans A. Particular matter
B. Particulate matter
C. Particulate material

D. Particulate micron

Question Type : MCQ
Question ID : 630680302493
Option 11D : 6306801176642
Option 2 1D : 6306801176644
Option 31D : 6306801176643
Option 4 ID : 6306801176645
Status : Answered
Chosen Option: C
Marks : -0.25

Q.47 What is the term used for the power of the President to withhold his assent to a bill?
Ans A. Dissolution

B. Adjournment
C. Veto

D. Prorogation

Question Type : MCQ
Question ID : 630680810227
Option 11D : 6306803174442
Option 2 ID : 6306803174441
Option 3 ID : 6306803174439
Option 4 ID : 6306803174440
Status : Answered

Chosen Option :
Marks :

Cc
1
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economic downturn?

Ans A. Reduced consumer spending
B. Higher inflation
C. Increased government debt

D. Excessive government borrowing

Q.48 Which of the following is a potential drawback of contractionary fiscal policy during an

GET IT ON

Google Play
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Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

:-0.25

Marks

McQ
630680774233
6306803034839
6306803034837
6306803034838
6306803034840
Answered

(o

Q.49 In the calculation of the Human Development Index (HDI), why is gross domestic
product (GDP) per capita adjusted for purchasing power parity (PPP)?

Ans A. To account for variations in economic growth rates
B. To reflect variations in the cost of living across countries
C. To account for differences in currency exchange rates

D. To standardise income levels across different population sizes

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
630680774311
6306803035148
6306803035147
6306803035145
6306803035146
Answered

B

1

Q.50 Trade credit allows for the acquisition of supplies without the need for immediate
payment and the buyer's records show this credit as:

Ans A. perspective creditor
B. supply debtors
C. advanced creditors

D. sundry creditors

Question Type :

Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
630680650766
6306802548040
6306802548041
6306802548039
6306802548038
Answered

B

-0.25

Section : Mental ability
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Q.51 Refer to the given series and answer the question that follows (all numbers are single
digit numbers only).

(Left)56269745185154734213784379 2 (Right)

How many such even digits are there, each of which is immediately preceded by an
odd digit and also immediately followed by an odd digit?

Ans A7
B.6
C.8
D.3

Question Type : MCQ
Question ID : 630680959438
Option 11D : 6306803761540
Option 2 ID : 6306803761539
Option 3 ID : 6306803761541
Option 4 ID : 6306803761538
Status : Answered
Chosen Option : D
Marks : 1

Q.52 P is the son of Z. Q is married to P. Y is the wife of Z. X is the brother of Y. W is married
to X. B is the father of Y. A is married to B. How is A related to Z?

Ans A. Wife’s sister
B. Mother
C. Daughter

D. Wife’s mother

Question Type : MCQ
Question ID : 630680285016
Option 11D : 6306801108040
Option 2 ID : 6306801108042
Option 3 ID : 6306801108041
Option 4 ID : 6306801108039
Status : Answered
Chosen Option : D
Marks : 1
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Q.53 In a certain code language, ‘WEAR’ is coded as ‘1537’ and ‘AIDS’ is coded as ‘6241°.
What is the code for ‘A’ in the given code language?

Ans A1
B.6
C.3
D.4

Question Type : MCQ
Question ID : 630680959457
Option 11D : 6306803761614
Option 2 ID : 6306803761617
Option 3 ID : 6306803761615
Option 4 ID : 6306803761616
Status : Answered
Chosen Option : B
Marks : -0.25

Q.54 Read the given statements and conclusions carefully. Assuming that the information
given in the statements is true, even if it appears to be at variance with commonly
known facts, decide which of the given conclusions logically follow(s) from the
statements.

Statements: Some kings are snakes. All butterflies are snakes.

Conclusion (l): Some kings are butterflies.
Conclusion (ll): All snakes are butterflies.

Ans A. Both conclusions (I) and (II) follow.
B. Only conclusion (1) follows.
C. Only conclusion (1) follows.

D. Neither conclusion (I) nor (I1) follows.

Question Type : MCQ
Question ID : 630680916197
Option 11D : 6306803589927
Option 2 ID : 6306803589928
Option 3 ID : 6306803589929
Option 4 ID : 6306803589926
Status : Answered
Chosen Option : D
Marks : 1
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Q.55 Read the given statements and conclusions carefully. Assuming that the information
given in the statements is true, even if it appears to be at variance with commonly
known facts, decide which of the given conclusion(s) logically follow(s) from the
statements.

Statements:
All shapes are squares.
All squares are rhombuses.

Conclusions:
(I) Some rhombuses are shapes.
(I) All shapes are rhombuses.

Ans A. Both conclusions (1) and (I1) follow.
B. Only conclusion (1) follows.
C. Neither conclusion (I) nor () follows.

D. Only conclusion (Il) follows.

Question Type : MCQ
Question ID : 630680917778
Option 11D : 6306803596271
Option 2 ID : 6306803596269
Option 3 ID : 6306803596272
Option 4 ID : 6306803596270
Status : Answered
Chosen Option : A
Marks : 1
Q.56 Seven boxes A, B, C, D, E, F and G are kept one above the other but not necessarily in
the same order. Only three boxes are kept above B. Only one box is kept between A
and B. Only three boxes are kept between A and C. C is kept at some place above B. G
is kept immediately below C. D is kept at one of the places above E. F is not kept
immediately above or below A. How many boxes are kept above G?
Ans A. One
B. Four
C. Three
D. Two
Question Type : MCQ
Question ID : 630680942297
Option 11D : 6306803693835
Option 21D : 6306803693838
Option 3 ID : 6306803693837
Option 4 ID : 6306803693836
Status : Answered
Chosen Option : A
Marks : -0.25
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Q.57 Laki starts from Point A and drives 7 km towards south. He then takes a right turn,
drives 5 km, turns right and drives 9 km. He then takes a right turn and drives 8 km. He
takes a final right turn, drives 2 km and stops at Point P. How far (shortest distance)
and towards which direction should he drive in order to reach Point A again?

(Note: All turns are 90 degree turns only unless specified.)
Ans A. 1 km to the south
B. 4 km to the west
C. 3 km to the west
D. 2 km to the north

Question Type : MCQ
Question ID : 630680750147
Option 1 ID : 6306802940079
Option 2 ID : 6306802940082
Option 3 ID : 6306802940081
Option 4 ID : 6306802940080
Status : Answered
Chosen Option : C
Marks : 1

Q.58 Refer to the following number, symbol series and answer the question. Counting to be
done from left to right only.
(Left) @#786*$3%1#54279% $ @ 6 2 (Right)
How many such symbols are there each of which is immediately preceded by a
number and also immediately followed by another number?

Ans A. Two
B. One
C. Four
D. Three

Question Type : MCQ
Question ID : 630680375965
Option 11D : 6306801464934
Option 2 ID : 6306801464931
Option 3 ID : 6306801464933
Option 4 ID : 6306801464932
Status : Answered
Chosen Option : A
Marks : 1
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Q.59 Eachof P, Q, R, S, T, U and V has an exam on a different day of a week starting from
Monday and ending on Sunday of the same week. P has an exam on Tuesday. Exactly
three people have an exam between P and V. T has an exam immediately before U, and
R has an exam immediately after U. Only one person has an exam between T and S.
How many people have exams between P and R?

Ans A. One
B. Two
C. Four
D. Three

Question Type : MCQ
Question ID : 630680908587
Option 11D : 6306803559418
Option 2 ID : 6306803559419
Option 3 ID : 6306803559421
Option 4 ID : 6306803559420
Status : Answered
Chosen Option : D
Marks : -0.25

Q.60 In a certain code language,
F + H means F is the brother of H,
F - H means F is the sister of H,
F x H means F is son of H and
F + H means F is the daughter of H.
Based on the above, If M+ S - T+ Q x V, then how is Q related to M?

Ans A. Brother
B. Mother’s brother
C. Son
D. Father

Question Type : MCQ
Question ID : 630680746389
Option 11D : 6306802925697
Option 2 ID : 6306802925696
Option 3 ID : 6306802925699
Option 4 ID : 6306802925698
Status : Answered
Chosen Option : D
Marks : -0.25
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Ans
A.

Q.61 if a and b, where a > b, are the roots of the equation 8x2-8x-6= 0, then what is the
value of (a - 2b)?
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Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
630680815611
6306803195744
6306803195742
6306803195741
6306803195743
Answered

B

-0.25

Ans A. 36
B. 26
C.20
D.6

Q.62 Let x be the greatest number which, when divides 3403, 1403 and 3424, the remainders
are 18, 49 and 39, respectively. What is the sum of the digits of x?

Question Type :
Question ID :
Option 11D :
Option 2D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
630680954774
6306803743307
6306803743305
6306803743304
6306803743306
Answered

B

-0.25
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remainders, is:

Q.63 The greatest number, which divides 1405 and 489 to leave 11 and 13 respectively as

Ans A. 36
B. 32
C.34
D. 39
Question Type : MCQ
Question ID : 630680788730
Option 11D : 6306803090702
Option 2 ID : 6306803090701
Option 3 ID : 6306803090700
Option 4 ID : 6306803090703
Status : Answered
Chosen Option: C
Marks : 1
Q.64 Kalpana and Sudha got 765 and 522 marks respectively in an examination. If Kalpana
scored 85% marks, then what is the percentage of marks scored by Sudha?
Ans A. 59%
B. 58%
C.61%
D. 56%
Question Type : MCQ
Question ID : 6306801021546
Option 11D : 6306804009234
Option 2 1D : 6306804009232
Option 3 ID : 6306804009235
Option 4 ID : 6306804009233
Status : Answered
Chosen Option : B
Marks : 1
Q.65 A shopkeeper marks an article at ¥x and offers a discount of 50% on it. He sells it for
¥399 after charging VAT of 52% on the discounted price. What is the value of ¥ x?
Ans A. %600
B. %500
C. %700
D. %525
Question Type : MCQ
Question ID : 630680844490
Option 11D : 6306803307888
Option 2 1D : 6306803307887
Option 3 ID : 6306803307889
Option 4 ID : 6306803307886
Status : Answered
Chosen Option : C
Marks : -0.25
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the same work in 12 days is:

Q.66 24 men can do a piece of work in 46 days. The number of men required to complete
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Ans A. 91
B. 89
C. 9%
D.92
Question Type : MCQ
Question ID : 630680948007
Option 11D : 6306803716723
Option 2 ID : 6306803716722
Option 3 ID : 6306803716721
Option 4 ID : 6306803716720
Status : Answered
Chosen Option : D
Marks : 1
Q.67 The average of 7 numbers is 45. If each number is increased by 5, what will the new
average be?
Ans A. 45
B. 55
C.7
D. 50
Question Type : MCQ
Question ID : 630680656748
Option 1 1D : 6306802570935
Option 2 ID : 6306802570936
Option 3 ID : 6306802570937
Option 4 ID : 6306802570934
Status : Answered
Chosen Option : B
Marks : -0.25
Q.68 Write the expanded form of (3a + 8b + 6c)?.
Ans A. 9a2 + 64b? + 36¢2 + 48ab + 91bc + 36ac
B. 9a2 + 64b? + 36¢2 + 48ab + 96bc + 46ac
C. 9a® + 64b? + 36¢? + 52ab + 96bc + 36ac
D. 9a2 + 64b? + 36¢2 + 48ab + 96bc + 36ac
Question Type : MCQ
Question ID : 630680827379
Option 1 ID : 6306803240854
Option 2 ID : 6306803240853
Option 3 ID : 6306803240852
Option 4 ID : 6306803240851
Status : Answered
Chosen Option: C
Marks : -0.25
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Q.69 Amit invested a certain sum of money at 10% per annum simple interest. If he receives
an interest of ¥39996 after 6 years, the sum (in %) he invested is:

Ans A. 65685
B. 66960
C. 66660
D. 66888

Question Type : MCQ
Question ID : 630680808921
Option 11D : 6306803169264
Option 21D : 6306803169265
Option 3 ID : 6306803169263
Option 4 ID : 6306803169266
Status : Answered
Chosen Option: C
Marks : 1

Q.70 Two trains having lengths of 280 m and 470 m are running at speeds of 60 km/h and
110 km/h, respectively, in the same direction. The time taken (in minutes) by the faster
train, coming from behind, to completely cross the other train is:

Ans A. 2
B.0.9
C.0.3
D. 1

Question Type : MCQ
Question ID : 630680950247
Option 11D : 6306803725638
Option 2 ID : 6306803725637
Option 3 ID : 6306803725639
Option 4 ID : 6306803725640
Status : Answered
Chosen Option : B
Marks : 1

Section : Basic Computer literacy

Q.71 In MS Excel, if a user wants to enter the number ‘5000’ into a cell, which of the
following methods is correct?

Ans A. Entering '5000.00' (with decimal points)
B. Entering '5 000" (with a space)
C. Entering '5000' (without a comma)

D. Entering '5,000' (with a comma)

Question Type : MCQ
Question ID : 6306801052225
Option 11D : 6306804131264
Option 2 ID : 6306804131265
Option 3 ID : 6306804131263
Option 4 ID : 6306804131262
Status : Answered
Chosen Option: C
Marks : 1
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Q.72 Which of the following is commonly use to manage and analyze large datasets,
perform statistical analysis, and generate reports?

Ans A. Business Intelligence Application
B. Photo Editor
C. Media player

D. Word Processing Application
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Question Type :
Question ID :
Option 11D :

: 6306803869013

Option 31D :

: 6306803869016

Status :

Chosen Option :

Marks :

Option 2 ID

Option 4 ID

McQ
630680986258
6306803869015

6306803869014

Answered

D
-0.25

errors in Microsoft Word?

Ans A. Go to the "Review" tab, then click on "Spelling and Grammar."
B. Press Ctrl+S.

C. Press F7.

menu.

Q.73 Which of the following options is NOT used for checking spelling and grammatical

D. Right-click on the text and choose "Check Spelling and Grammar" from the context

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
630680770596
6306803020286
6306803020288
6306803020285
6306803020287
Answered

B

1

Q.74 Which icon on the desktop represents a temporary holding place for files that are
deleted?

Ans A. My Computer
B. Wallpaper
C. Recycle Bin

D. Taskbar

Question Type :
Question ID :
Option 11D :
: 6306803009771
Option 31D :
Option 4 ID :
Status :

Chosen Option :

Marks :

Option 2 ID

McQ
630680767877
6306803009772

6306803009770
6306803009769
Answered

(o

1
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Q.75 What is the default width of a column in MS Excel?

Ans A. 2 characters
B. 8.43 characters
C. 4 characters

D. 16 characters
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Question Type : MCQ
Question ID : 630680773052
Option 11D : 6306803030185
Option 2 1D : 6306803030187
Option 3 ID : 6306803030186
Option 4 ID : 6306803030188
Status : Answered
Chosen Option: C
Marks : -0.25
Q.76 Which of the following methods can be used to insert a video file into a PowerPoint
slide in MS Office PowerPoint 2007?
Ans A. Go to the 'File' tab -> Click on 'Open' -> Choose the video file
B. Go to the 'Design' tab -> Select 'Insert Video' -> Browse for the video file on your
computer
C. Go to the 'Insert' tab -> Click on 'Movie' -> Select 'Movie from file' to add a video
D. Right-click on the slide -> Select 'Insert' -> Choose 'Video from Text Box'
Question Type : MCQ
Question ID : 6306801049511
Option 11D : 6306804120293
Option 2 ID : 6306804120294
Option 3 ID : 6306804120292
Option 4 ID : 6306804120295
Status : Answered
Chosen Option: C
Marks : 1
Q.77 In modern CPUs, which of the following techniques is primarily used to increase
instruction-level parallelism and improve processing efficiency?
Ans A. Virtualisation
B. Pipelining
C. Caching
D. Hyperthreading
Question Type : MCQ
Question ID : 6306801056045
Option 11D : 6306804146688
Option 21D : 6306804146686
Option 3 1D : 6306804146687
Option 4 ID : 6306804146689
Status : Answered
Chosen Option : A
Marks : -0.25
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Q.78 Modern mobile phones and tablets utilise specialised operating systems optimised for
touchscreen interfaces and resource constraints. Which of the following statements
correctly describes a key distinction between Android and iOS operating systems in
terms of software distribution and system architecture?

Ans A. Android devices exclusively use ARM architecture processors, while iOS devices are
capable of using both ARM and x86 architecture processors.
B. iOS provides full customisation of the system interface, while Android is restricted to
manufacturer-defined interfaces.

C. Android supports third-party app stores and is based on the open-source Linux
kernel, while iOS restricts app distribution to the Apple App Store and is built on a closed-
source UNIX architecture.

D. Both Android and iOS are open-source operating systems that allow installation of
apps from multiple sources.

Question Type : MCQ
Question ID : 6306801058284
Option 1 ID : 6306804155521
Option 2 ID : 6306804155520
Option 3 ID : 6306804155518
Option 4 ID : 6306804155519
Status : Answered
Chosen Option : B
Marks : -0.25

Q.79 Rahul has created a presentation. There are two slides in his presentation that he does
not want to appear during the slide show. What should he do?

Ans A. Add special effects to the two slides
B. Hide the slides
C. Create a new presentation

D. Delete the two slides

Question Type : MCQ
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Q.80 Which of the following is the first step in creating a new MS Word document?
Ans A. Click on File > Save As

B. Click on File > New
C. Click on File > Print

D. Click on File > Open
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